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Data Requirements for Data Requirements for 
Unsteady Flow ModelsUnsteady Flow Models

Cameron Ackerman, P.E.Cameron Ackerman, P.E.

The objective of this lecture is to discuss geomtric data options in HEC-RAS and 
how the geometric pre-processsor uses the geometric to preprocess hydraulic 
tables for use in unsteady flow simulations.
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Geometry PreprocessorGeometry Preprocessor

What does it do?What does it do?
Processes geometric data into a series of Processes geometric data into a series of 
hydraulic tables and rating curves.hydraulic tables and rating curves.

Why do we use it for unsteady flow?Why do we use it for unsteady flow?
Instead of calculating hydraulic variables for Instead of calculating hydraulic variables for 
each crosseach cross--section during each iteration, the section during each iteration, the 
program interpolates the hydraulic variables program interpolates the hydraulic variables 
from the tables.from the tables.

The preprocessor is used to process the geometric data into a series of 
hydraulic property tables and rating curves.  This is done in order to speed 
up the unsteady flow calculations.  Instead of calculating hydraulic variables 
for each cross-section during each iteration, the program interpolates the 
hydraulic variables from the tables.  The preprocessor must be executed at 
at least once, but then only needs to be re-executed if something in the 
geometric data has changed.

1.4 L-04



Geometry Requirements\GWB\CTA 3

3

Hydraulic Property PlotHydraulic Property Plot

Cross sections are processed into tables of elevation versus hydraulic 
properties of areas, conveyances, and storage.  Each table contains a 
minimum of 21 points (a zero point at the invert and 20 computed values).  
The user is required to set an interval to be used for spacing the points in the 
cross section tables.  The interval can be the same for all cross sections or it 
can vary from cross section to cross section.  This interval is very important, 
in that it will define the limits of the table that is built for each cross section.  
On one hand, the interval must be large enough to encompass the full range 
of stages that may be incurred during the unsteady flow simulations.  On the 
other hand, if the interval is too large, the tables will not have enough detail 
to accurately depict changes in area, conveyance, and storage with respect 
to elevation.
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Conveyance CalculationsConveyance Calculations

ManningManning’’s Equation s Equation 

2/1
fSKQ =

3/2486.1 RA
n
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Conveyance is calculated from the above form of Manning’s equation (based 
on English units):

where:
K =  conveyance for subdivision
n =  Manning's roughness coefficient for subdivision
A =  flow area for subdivision
R =  hydraulic radius for subdivision (area / wetted perimeter)
Sf =  friction slope
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Conveyance CalculationsConveyance Calculations

nch n1 n2 n3 

A1 P1 A2 P2 A3 P3 Ach Pch 

Klob = K1 + K2 

Kch 

Krob = K3 

The determination of total conveyance and the velocity coefficient for a cross 
section requires that flow be subdivided into units for which the velocity is 
uniformly distributed.  The approach used in HEC-RAS is to subdivide flow in 
the overbank areas using the input cross section n-value break points 
(locations where n-values change) as the basis for subdivision.

The program sums up all the incremental conveyances in the overbanks to 
obtain a conveyance for the left overbank and the right overbank.  The main 
channel conveyance is normally computed as a single conveyance element.  
The total conveyance for the cross section is obtained by summing the three 
subdivision conveyances (left, channel, and right).

1.4 L-04



Geometry Requirements\GWB\CTA 6

6

Cross Section ExampleCross Section Example
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Cross Section Table Cross Section Table ParametersParameters

View HTAB Parameters

The Geometric Data Editor is shown in the above figure.  From this editor, 
select the button labeled Htab Param. to view and edit the cross section 
table parameters.
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Cross Section Table Cross Section Table ParametersParameters

Starting ElevationStarting Elevation
IncrementIncrement
Number of PointsNumber of Points

As shown in the figure, the table contains three columns in which the user 
can enter information: starting elevation; increment; and Number of Points.  
The first time the user opens this editor all of the columns are automatically 
filled.  The starting elevation columns are automatically filled to an elevation 
one foot higher than the invert, however, the user can change these values 
to whatever they want.  The second and third columns are used for the table 
increment and the number of points.  These two variables will describe the 
extent to which the table encompasses the cross section data.  A default 
value will be set for the increment and the number of points.  Normally the 
increment will be set to one foot, and the number of points will be set to a 
value that will allow the table to extend to the top of the cross section.  If this 
combination would end up with less than 20 points, then the number of 
points is set to 20 and the increment is reduced to get the table to the top of 
the cross section.  The user can set these values individually for each cross 
section, or they can highlight a series of cross sections and use the Set 
Values button to enter the value for all of the highlighted sections. Other 
options are available to multiply highlighted fields by a factor or add a 
constant to all of them.  Additionally, cut, copy, and paste buttons are 
available for manipulating the data.
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Entering Geometric Entering Geometric 
ParametersParameters

ManningManning’’s n Valuess n Values
Ineffective Flow AreasIneffective Flow Areas

NonNon--Permanent vs. PermanentPermanent vs. Permanent
Normal vs. Multiple BlocksNormal vs. Multiple Blocks

Blocked ObstructionBlocked Obstruction
LeveesLevees
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Entering Geometric Entering Geometric ParametersParameters

Geometric Data Editor

The Geometric Data Editor is shown in the above figure.  From this editor, 
select the button labeled Cross Section to view and edit the cross section 
geometry.
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ManningManning’’s n Valuess n Values

Selection of an appropriate value for Manning’s n is very significant to the 
accuracy of the computed water surface profiles.  The value of Manning’s n 
is highly variable and depends on a number of factors including: surface 
roughness; vegetation; channel irregularities; channel alignment; scour and 
deposition; obstructions; size and shape of the channel; stage and 
discharge; seasonal change; temperature; and suspended material and 
bedload.
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ManningManning’’ss n Valuesn Values

The above figure illustrates the horizontal variation in Manning’s n values 
along the cross section.

There are several references a user can access that show Manning's n 
values for typical channels.  An extensive compilation of n values for streams 
and floodplains can be found in Chow’s book “Open-Channel Hydraulics”
[Chow, 1959].  Excerpts from Chow’s book, for the most common types of 
channels, are shown in Table 3.1 of the Hydraulic Reference Manual for 
HEC-RAS version 3.0 on pages 3-14 and 3-15.
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Entering Geometric Entering Geometric 
ParametersParameters

ManningManning’’s n Valuess n Values
Ineffective Flow AreasIneffective Flow Areas

NonNon--Permanent vs. Permanent Permanent vs. Permanent 
Normal vs. Multiple BlocksNormal vs. Multiple Blocks

Blocked ObstructionBlocked Obstruction
LeveesLevees
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Ineffective Flow AreasIneffective Flow Areas

Areas where water is not actively being Areas where water is not actively being 
conveyed.  The velocity of water in the conveyed.  The velocity of water in the 
downstream direction is close to zero.downstream direction is close to zero.
This water is included in the storage This water is included in the storage 
calculations and other wetted cross calculations and other wetted cross 
section parameters, but it is not included section parameters, but it is not included 
as part of the active flow area. as part of the active flow area. 

This option allows the user to define areas of the cross section that will 
contain water that is not actively being conveyed (ineffective flow).  
Ineffective flow areas are often used to describe portions of a cross section 
in which water will pond, but the velocity of that water, in the downstream 
direction, is close to zero.  This water is included in the storage calculations 
and other wetted cross section parameters, but it is not included as part of 
the active flow area.

In  unsteady flow modeling it is important to account for channel storage as 
well as conveyance.  In steady flow modeling it is sometimes possible to 
completely ignore portions of the cross section that are dead storage, this is 
not the case in unsteady flow modeling because the hydrograph volume 
must be recognized.  It may be useful to think of storage-only portions of a 
cross section as having extremely high n-values, which effectively nulls the 
conveyance.
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Ineffective Flow Areas RequirementsIneffective Flow Areas Requirements

Ineffective Flow StationsIneffective Flow Stations
Left and/or right ineffective flow stations Left and/or right ineffective flow stations 
denote the location of the ineffective flow denote the location of the ineffective flow 
areas along the cross section.areas along the cross section.

Trigger ElevationsTrigger Elevations
Water elevation at which the ineffective flow Water elevation at which the ineffective flow 
area begins to convey flow (nonarea begins to convey flow (non--permanent), permanent), 
or remains ineffective (permanent).  or remains ineffective (permanent).  

Setting an ineffective flow area requires at least one bank station and 
elevation.  The bank station denotes the location of the ineffective flow area 
along the cross section.  There are two different methods for setting bank 
stations (normal and multiple blocks).  

When the water surface surpasses the trigger elevation, the ineffective flow 
area will either begin to convey flow or remain ineffective depending upon its 
type (permanent on non-permanent). The concepts of permanent and non-
permanent ineffective flow areas are addressed in the next set of slides.
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NonNon--Permanent Ineffective Flow AreaPermanent Ineffective Flow Area

As shown in the slide, there are two ineffective flow areas (left bank and right 
bank).  The ineffective flow areas are set to non-permanent.  This means 
that the left bank and right bank areas will not convey flow until the trigger 
elevation has been reached.  The trigger elevation is denoted by the end 
point of the two arrows.  In this example the trigger elevation is 216 feet.
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NonNon--Permanent Ineffective Flow AreaPermanent Ineffective Flow Area

The water surface is rising but has not exceeded the trigger elevation.  The 
rising water surface has increased the storage in the left and right overbanks 
but has not increased the conveyance in these areas because ineffective 
flow areas account for storage and not conveyance.  
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NonNon--Permanent Ineffective Flow AreaPermanent Ineffective Flow Area

For non-permanent ineffective flow areas, once the water surface is higher 
than the trigger elevation, the entire ineffective flow area becomes effective 
(as shown in the slide).  Water is assumed to be able to move freely in that 
area based on the roughness, wetted perimeter, and area of each 
subdivision.  The left and right overbanks are no longer considered storage 
but are now active flow areas.  
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PermanentPermanent Ineffective Flow AreaIneffective Flow Area

Occasionally you may need to have ineffective flow areas remain ineffective 
permanently.  The ineffective flow areas can be set to the permanent mode 
individually from the cross section editor, or through a table from the 
geometric data editor.

In this example, the same ineffective flow areas were used except they were 
set to permanent.  As seen in the slide when the water surface is below the 
trigger elevation the permanent ineffective flow area behaves like the non-
permanent area.
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PermanentPermanent Ineffective Flow AreaIneffective Flow Area

For permanent ineffective flow areas, when the water surface elevation 
surpasses the trigger elevation, the area below the trigger elevation remains 
ineffective. Water above the trigger elevation is assumed to convey flow.
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Normal Ineffective Flow AreasNormal Ineffective Flow Areas

The normal ineffective flow area option allows the user to define a left station 
and elevation and a right station and elevation (normal ineffective areas).  
When this option is used, and if the water surface is below the established 
ineffective elevations, the areas to the left of the left station and to the right 
of the right station are considered ineffective.
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Normal Ineffective Flow AreasNormal Ineffective Flow Areas

Set the normal ineffective flow area locations by selecting Ineffective Flow 
Areas under the Options menu of the Cross Section Data Editor.  In the 
ineffective flow area window, select the radio button labeled Normal.  Notice 
the box labeled Permanent, check this box if the ineffective flow area never 
conveys flow.
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Blocked Ineffective Flow AreasBlocked Ineffective Flow Areas

The multiple block ineffective area option allows for the establishment of 
blocked ineffective flow area .  Multiple blocked ineffective flow areas are 
useful for bridge geometry with slopes or multiple openings.
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Blocked Ineffective Flow AreasBlocked Ineffective Flow Areas

Blocked ineffective flow areas require the user to enter an elevation, a left 
station, and a right station for each ineffective block.  Up to ten blocked 
ineffective flow areas can be entered at each cross section.  Notice the 
column labeled Permanent (y/n), change this column to “y” for permanent 
ineffective flow areas.
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Entering Geometric Entering Geometric ParametersParameters

ManningManning’’s n Valuess n Values
Ineffective Flow AreasIneffective Flow Areas

NonNon--Permanent vs. Permanent Permanent vs. Permanent 
Normal vs. Multiple BlocksNormal vs. Multiple Blocks

Blocked ObstructionBlocked Obstruction
LeveesLevees
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BlockedBlocked ObstructionsObstructions

Decrease Flow AreaDecrease Flow Area
Add Wetted PerimeterAdd Wetted Perimeter

Blocked obstructions allow the user to define areas of the cross section that 
will be permanently blocked out.  Blocked obstructions decrease flow area 
and add wetted perimeter when the water comes in contact with the 
obstruction.  A blocked obstruction does not prevent water from going 
outside of the obstruction. 
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BlockedBlocked ObstructionsObstructions

The user may define a left station and elevation and a right station and 
elevation (normal blocked areas).  When this option is used, the area to the 
left of the left station and to the right of the right station will be completely 
blocked out. 
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Entering Geometric Entering Geometric 
ParametersParameters

ManningManning’’s n Valuess n Values
Ineffective Flow AreasIneffective Flow Areas

NonNon--Permanent vs. Permanent Permanent vs. Permanent 
Normal vs. Multiple BlocksNormal vs. Multiple Blocks

Blocked ObstructionBlocked Obstruction
LeveesLevees

1.4 L-04



Geometry Requirements\GWB\CTA 29

29

LeveesLevees

Levee

This option allows the user to establish a left and/or right levee station and 
elevation on any cross section.  When levees are established, no water can 
go to the left of the left levee station or to the right of the right levee station 
until either of the levee elevations are exceeded.  Levee stations must be 
defined explicitly, or the program assumes that water can go anywhere 
within the cross section.  An example of a cross section with a levee on the 
left side is shown in the figures.  In this example the levee station and 
elevation is associated with an existing point on the cross section. 

1.4 L-04



Geometry Requirements\GWB\CTA 30

30

LeveesLevees
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Graphical Cross Section Graphical Cross Section EditorEditor

LocatedLocated in the in the Geometric Data EditorGeometric Data Editor under the under the ToolsTools menu.menu.

A graphical cross section editor is available from the Tools menu of the 
Geometric Data Editor.  The user has the option to move objects (objects 
are ground points, main channel bank stations, ineffective flow areas, 
levees, and blocked obstructions), delete objects, or add new objects.  

To move an object, the user first selects Move Objects from the Options
menu.  Then move the mouse pointer over the object that you want to move, 
press down the left mouse button, and then move the object.  When you are 
finished moving the object, simply release the left mouse button and the 
object will be moved.  To delete an object, first select Delete Objects from 
the Options menu.  Next, move the mouse pointer over the object that you 
would like to delete and click the left mouse button.  Whatever object is 
closest to the mouse pointer will be deleted.  To add an object to the cross 
section, first select the type of object you want to add from the available list 
under the Options menu.  Once you have selected an object type to add, 
move the mouse pointer to the location where you would like to add it and 
click the left mouse button.  If the object that you are adding requires more 
than one point, such as blocked ineffective flow areas and blocked 
obstructions, then continue to move the mouse pointer and click the left 
mouse button to add the additional points.
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Setting Ineffective Areas to PermanentSetting Ineffective Areas to Permanent

LocatedLocated in the in the Geometric Data EditorGeometric Data Editor under the under the ToolsTools menu.menu.

The default in HEC-RAS is to set ineffective flow areas to non-permanent.  
To change a set of river stations from non-permanent to permanent, select 
Setting Ineffective Areas to Permanent Mode… under the Tools menu 
located in the Geometric Data Editor.  Then select the proper river, reach, 
and river stations.

This is especially useful after using the Graphical Cross Section Editor
because there is no option in the editor to change between non-permanent 
and permanent.
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GeometryGeometry PreprocessorPreprocessor

The geometric preprocessor is located in the Unsteady Flow Analysis 
Window, found from the main program window under the Run menu.
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HydraulicHydraulic Property TablesProperty Tables

View output from the geometric preprocessor by examining the hydraulic 
property tables and plots.  The output is located under the View menu, or 
the shaded button in the figure.

1.4 L-04



Geometry Requirements\GWB\CTA 35

35

HydraulicHydraulic Property PlotProperty Plot

Output can be viewed in graphical form.  Viewing the graphical output is a 
good diagnostic tool for examining cross section geometry.  The relationship 
of area, storage, and conveyance should be examined for abrupt changes 
with elevation.  Any abrupt changes should be reviewed to determine the 
overall significance within that particular model. 
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HydraulicHydraulic Property TableProperty Table

Detailed output is also available for each computed increment.  Detailed 
output can be examined to determine a specific elevation or station where a 
problem is occurring.  
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Geometry and Unsteady FlowGeometry and Unsteady Flow

What is going to happen to the water What is going to happen to the water 
when it gets out of the channel?when it gets out of the channel?

Ineffective Flow AreasIneffective Flow Areas
LeveesLevees
Conveyance Calculations Using SubdivisionsConveyance Calculations Using Subdivisions

When examining geometry, the user must consider where water may leave 
the main channel and how it will behave once out of the main channel.  
Knowing these factors gives the user a general idea of how to correctly 
model the situation within the framework of HEC-RAS.
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IneffectiveIneffective Flow AreasFlow Areas

As seen in the figure, there is water in the right overbank.  Because RAS is a 
one-dimensional model, the water surface elevation will be the same for the 
entire cross section.  The user must determine if water can physically enter 
the right overbank at this cross section by examining upstream and 
downstream cross sections.  

If water will enter the right overbank then the user must determine how to 
model this area.  
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NonNon--Permanent Ineffective FlowPermanent Ineffective Flow

The figure above represents the previous cross section with the right 
overbank modeled as non-permanent ineffective flow.  As seen on the figure, 
the storage in the cross section increases until reaching the trigger elevation 
where the ineffective flow area is turned off. By turning off the ineffective flow 
area the storage in the cross section returns to zero and the area of the 
cross section increases.  

If the water level could possibly reach the trigger elevation then this is 
probably not the proper way to model this cross section.  The change in 
volume of storage, and the change in area of the cross section, is too 
significant to model with a non-permanent ineffective flow area. 
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Permanent Ineffective Flow AreaPermanent Ineffective Flow Area

The figure above represents the previous cross section with the right 
overbank modeled as permanent ineffective flow.  As seen on the figure, the 
storage in the cross section increases until reaching the top of the ineffective 
flow area where it remains constant. 

If the water level could possibly reach the trigger elevation, while remaining 
relatively stationary, then this is probably a better representation compared 
to a non-permanent ineffective flow area.
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LeveesLevees

If it is determined that water will not enter the right overbank, then the area 
should be modeled with a levee.  When the levee is established, no water 
can go to the right of the right levee station until the levee elevation is 
exceeded.   

1.4 L-04



Geometry Requirements\GWB\CTA 42

42

LeveesLevees

As seen on the figure, if the levee elevation is exceeded there will be an 
extremely large increase in conveyance with elevation for this geometry.  
This would not be the proper way to model the cross section if the levee is 
overtopped.  Keep in mind that the magnitude of conveyance on the x-axis is 
divided by 1000.
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Storage Area OptionStorage Area Option

What if adding a levee or ineffective flow What if adding a levee or ineffective flow 
area has a significant affect on the area has a significant affect on the 
conveyance and storage relationships?conveyance and storage relationships?

Alter the cross section by terminating it at the Alter the cross section by terminating it at the 
beginning of the problem area.beginning of the problem area.
Model the area that was deleted with a lateral Model the area that was deleted with a lateral 
weir and offweir and off--stream storage area.stream storage area.
Storage areas will be discussed in impending Storage areas will be discussed in impending 
lectures.lectures.

If the cross sectional geometry denotes a significant change in storage or 
conveyance when a levee is overtopped then this cross section should be 
altered.  The cross section should be terminated at the levee and the area 
that was deleted should be modeled as a storage area.  Abrupt and 
significant changes in storage and conveyance should be avoided because 
they can cause instabilities in the unsteady flow model.
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ConveyanceConveyance SubdivisionsSubdivisions

As shown in the figure above, there is a distinct increase in elevation located 
at station 2000.  The entire left bank is being modeled with one Manning’s n 
value.  Remember that RAS computes the left and right overbank 
conveyances using subdivision of Manning’s n.
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ConveyanceConveyance SubdivisionsSubdivisions

As seen in the figure, there is a hitch in the increase of conveyance with 
elevation at just above 75 feet.  This corresponds to the steep increase in 
elevation located at station 2000 on the previous figure.

HEC-RAS uses Manning’s equation to calculate conveyance.  Imbedded in 
this equation are relationships for channel depth, channel area, and wetted 
perimeter.  In this example, when the calculations go just above the 
elevation of 75 feet, Manning’s equation sees an enormous increase in 
wetted perimeter for a minute increase in water depth.  The conveyance 
answer found from this calculation is dramatically different from the 
conveyance answer found at the previous calculation below 75 feet.
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ConveyanceConveyance SubdivisionsSubdivisions

To account for this situation, a subdivision made by inserting another 
Manning’s n value must be added at the point of discontinuity.  The value 
does not need to be different, as long as the subdivision is present, RAS will 
calculate separate conveyances for the geometry.
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ConveyanceConveyance SubdivisionsSubdivisions

As seen on the figure, this subdivision for the left overbank smoothed the 
relationship between conveyance and elevation.
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Questions?Questions?
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